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Typographie

Nom d'une fenêtre d'OOo ou Boite de dialogue comme Légende , Style et formatage (qui 
est souvent appelée Styliste F11)
Icônes Bouton comme Insérer, Fermer, ou  OK

Onglet sous une fenêtre comme Renvois ou Arrière-plan.
Sous  un  onglet,  choix  de  paramètres  comme  Propriétés et  Légende,  incluant  les 
paramètres Type, Séparateur
Menu Format > Paragraphe...> Ouvrir et dérouler un des menus de la barre Menu.
Un clic droit ouvre un menu contextuel où une option est à choisir comme Modifier, 
Ancrage, Légende...
Les données à taper au clavier sont indiquées en gras sans quottes (" " ni «  »)
Lorsqu'il risque d'avoir une confusion , un style, un nom bien déterminé est souligné : 

Standard et Titre 1 sont des styles natifs d'OOo, Glaïeuls est un style personnalisé.
Aide .:Les raccourcis-clavier, les combinaisons de touches (appui simultané sur plusieurs 

touches et les touches du clavier n'ont pas de signe particulier . F11 est la touche 
Fonction du clavier, Ctrl en est sa touche Contrôle. Ctrl+N  est une combinaison 
des touche Ctrl et N

Les fenêtres ouvertes par les commandes seront appelées indifféremment Fenêtre ou 
Boite de dialogue, question de lisibilité ou de place occupée (7 ou 17 caractères) 
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1. But du tutoriel et pré requis

1.1. But

Ajouter des légendes à des objets insérés dans un document texte
(images, tableaux, cadres-texte, des objets de dessin, objets OLE :-formules du module 
Math, classeurs du module Calc, etc.),

en y appliquant une numérotation automatique en fonction d'une catégorie précise. 

Utiliser ces légendes numérotées comme cibles dans ce document , c-à-dire placer à un 
endroit précis du texte une référence dirigeant vers l'objet référencé. 

1.2. Exemple

Bonjour,
Si vous n'aimez pas les glaïeuls jaunes (voir Glaïeuls 1 : Jaune), allez voir si les ambres 
vous conviennent (voir Glaïeuls 2), sinon vous aimerez peut-être les grenats (ici : Grenat) 
.

En passant avec la souris sur la Référence, une note s'affiche, il faut cliquer pour se rendre sur 
la cible correspondante.

1.3. Principe

L'ajout d'une légende crée
➢ un cadre

➢ un champ Variable de type Séquence

Le cadre sélectionné, 
bordure Magenta avec 
ses poignées vertes

Le champ Séquence Ref. 
surligné en jaune

L'utilisation d'une Référence nécessite la création d'un champ Renvois.

Voici le même exemple avec l'affichage du Nom(s) de champ ainsi que l'affichage de Trame 
de fond de champs ( ex Marques) :
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Objets avec chacun une légende et un numéro automatique 
qui servent de cible , chaque cible étant appelée un Renvoi

Texte Writer
Dans ce document texte, s'insèrent des Références qui permettent de joindre la 

cible correspondante = Renvoi.
Allez à Réf.1 ;  Allez à Réf.2 ; Voir l'image 1; Voir l'image 2 ; Voir l'image 3

La création des Renvois ou cibles doit précéder l'indication de la Référence

Renvois

Catégorie Réf.

Réf..1 Réf..2

Catégorie Image

Image 1 Image 2 Image 3



1.4. Pré requis au niveau des cadres

Le tutoriel Tout sur les cadres apporte des précisions non indispensables pour ajouter des 
légendes mais sera utile pour ceux qui voudront aller plus loin .

Actions sur le cadre

Un clic sur son bord le sélectionne avec ses 8 poignées vertes 
Un double clic sur son bord le sélectionne et ouvre la boite de dialogue Cadre

Déplacement 
à la souris

au clavier

A l'intérieur du cadre sélectionné, le curseur prend la forme de la croix  
qui permet de le déplacer par glisser de la souris;

Pas à pas avec les touches directionnelles , , ,

Finement en appuyant en même temps sur la touche Alt  

Modification des 
dimensions

Par cliquer et glisser sur les poignées vertes  

Cliquer en dehors ou appuyer la touche <Echap> pour quitter la sélection du cadre

Pour écrire, cliquer dans la cadre non sélectionné (sans ses poignées vertes)

Pour supprimer un cadre : sélection puis touche <Suppr> du clavier.
 (ou Navigateur F5, menu contextuel du cadre en question)

1.5. Pré requis pour les Champs

1. Affichage des Champs : modifier leur apparence 

Menu : Affichage >
Cochez Trame de fond des champs. (ex : Marques )

Pendant tout le travail , il est indispensable d'afficher la 
Trame de fond des champs qui surligne le champ créé 
mais il faut aussi changer l'affreux grisé.

Menu : Outils > Options...> OpenOffice.org  (1) > 
Apparence >  Zone Couleurs personnalisées (2)

Passer de

à
Page n° 4 sur 20
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Choisissez des couleurs qui vous aideront dans votre travail, délimitation du texte, des objets, 
des tableaux etc. en cliquant sur le petit triangle inversé de la liste déroulante pour 
remplacer Automatique

puis un peu plus bas (3 et 4),Trame de fond des champs (5)et profitez pour modifier la 
couleur de Sauts de page et de colonne en Rouge clair si vous ne l'avez pas déjà fait.

Vous retrouverez ces couleurs dans le tutoriel.

2. Affichage de la Valeur ou bien du Nom des champs

Ne pas cochez Noms de champ sauf pour vérifier ce qui se passe. 

Exemple de la Numérotation de pages, habituellement placé dans le Pied de page :

Page n° 5 sur 20 , indique la valeur des champs : le numéro de la page courante (5) 
sur le total des pages 20.

en cochant Noms de champ ou avec le raccourcis clavier Ctrl + F9 devient :

Page n° Numéro de page sur Statistiques ce qui explicite l'insertion des champs.
Toujours avoir à l'esprit quand on utilise les champs à cette éventualité lorsque ne 
s'affiche pas ce qui est attendu !

1.6. Niveau de compétence requis

Comme tout logiciel, OOo peut être utilisé à 10 % de ses capacités. 
L'affichage des légendes ne nécessite pas de compétences particulières, le système de renvois est un 

peu plus complexe. Ce tutoriel s'adresse cependant à un utilisateur déjà averti.
Je conseille donc en plus de lire ou relire Tout sur les cadres
celui sur les Titres pour la numérotation des chapitres, qui traite aussi de la gestion des styles et des 

modèles , Tout sur les styles de titre 
Il est d'autres méthodes d'insertion d'images , de texte, de légendes, de numérotation automatique et 

de système de renvois qui ne peuvent pas prendre leur place ici.

Tutoriels :
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2. Ajouter les légendes

2.1. Placer les légendes aux images insérées.

1. Insérer vos images.

Menu : Insertion > Image > A partir d'un fichier...

2. Sélectionnez la première image...

Clic droit sur l'image > Légende... dans le menu contextuel.

Ou par le menu : Insertion > Légende

3. La boite de dialogue Légende

Voici dans un nouveau document l'affichage par défaut de la boite de dialogue Légende

Dans la zone Légende, 
saisir le texte de la 
légende.

En Propriétés :

① Catégorie :

La zone Catégorie est 
inscriptible :on peut y 
taper du texte.

ou bien choisir dans sa 
liste attachée.

Par défaut, la liste déroulante ne propose 
que 5 choix, 
il manque bizarrement Réf.

Ajouter une catégorie

Chaque nom validé dans cette zone crée une nouvelle Catégorie.
Vous pouvez ajouter autant de catégories en les nommant à chaque nouvelle série 

d'objets que vous voulez référencer ensemble 
Par exemple, quand vous aurez à placer une légende à des graphiques,

vous taperez Graphique...dans cette zone :
Sélectionnez la catégorie affichée (ici Illustration) par glisser de la souris 
ou Touche Suppr dans la zone puis tapez le nom de votre nouvelle catégorie.
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Exemples de catégories NB

Référence Réf. Image Copie_d_écran pose le problème de

Graphique Diagramme Photo l'apostrophe et de l'espace qui sont interdits.

Cadre Cadre-texte Math Nous en verrons la raison quand nous

Boxer Glaïeuls Formule supprimerons une catégorie. Y aller

➁ Numérotation 

Choisir parmi les 7 modes habituels par la liste déroulante ;

➂ Séparateur 

Placer un espace avant les deux points : afin d'avoir une présentation plus raffinée : Par 
défaut : Illustration :1 (le nombre est collé aux deux points : ) au lieu de Illustration : 1 

➃ La zone d'aperçu vous montre le résultat de vos choix 

Validez par le bouton OK.

Exemple pour vos 
photos : vous voulez 
référencer les 
différents glaïeuls de 
votre jardin :

Créez donc la catégorie 
Glaïeuls en 1, 

Tapez le texte propre à la 
photo  en 2,

Placez un espace en 3 
avant les deux points

Regardez si cela vous 
convient en 4 

validez par OK >

Glaïeuls 1 : Jaune Retour

Sur une deuxième image de la même 
catégorie,par exemple, il suffira de 
vérifier si Glaïeul est bien sélectionné et 
tapez le Texte Ambre dans la zone 
Légende.

Glaïeuls 2 : Ambre Retour
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2.2. Autres objets

1. Objets OLE

Rappel : Menu > Insertion > Objets > Objets OLE...
Dans la fenêtre Insérer un objet OLE, choisir l'objet désiré.

Exemple d'un objet OLE... obtenu en cochant Créer un nouvel objet  et en choisissant
comme type d'objet : Classeur Ooo-dev 3.0  (soit sous Ooo2.4 : Classeur 
OpenOffice.org2.4)

Clic droit sur l'objet> Légende... > 
Dans la boite de dialogue Légende, 

Tapez Tableau dans la zone Catégorie (1)
Tapez votre texte dans la zone 2 
Choisir le type de numérotation ou laisser 
par défaut Arabe (1 2 3)
Placer un espace avant les : en 3

Deuxième exemple d'un objet OLE obtenu en cochant Créer à partir d'un fichier existant 
(OOoCalc )
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2. Diagrammes 

Exemple pour un premier graphique

Obtenu par Insérer > Diagramme A partir d'un fichier Calc

Graphique 1 : Exemple diagramme

3. Cadre rectangle et cadre Texte de la barre de Dessin

Exemples de Cadre rectangle 

Texte 1 : Rappel Cadre-Rectangle

Texte 2 : Cadre Rectangle Remplissage

Exemples de Cadre-texte comme T

Texte 3: Cadre-Texte comme T
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   Barre d'outils Dessin > Icône T comme Texte
   Pour mieux voir le Cadre-texte
   > Lignes... > Style Continu (pour la Bordure)
   > Remplissage...  > Remplissage > Couleurs > Jaune2

Graphique 2 : Présences

Rappel par la Barre d'outils Dessin > Icône rectangle bleu

Remplissage > Dégradés > Avocat

Ligne 1 Ligne 2 Ligne 3 Ligne 4
0

2

4

6

8

10

12

1 colonne
2 colonne
3 colonne



Texte 4: Cadre texte Barre d'outil dessin T

4. Cadres et tableaux Writer

 Exemples des 2 cas particuliers des Cadres. La légende s'inscrit directement dans le cadre.

Cadre 1 : Exemple avec la position : Infra

Cadre 2 : Exemple avec la position : Supra

 Exemple d'un tableau Writer 

Il ne faut pas le sélectionner, seulement mettre le pointeur dans une cellule ,
et toujours par clic droit > Légende... >
La légende se place dans le paragraphe suivant le tableau.

Tableau 1 : Tableau Writer du document ouvert

2.3. Déplacement ou suppression d'un objet référencé

L'objet référencé se traite comme un cadre (sauf pour les tableaux Writer).

Cas général 

L'ajout d'une légende insère l'image dans un cadre.

 Il faudra donc faire attention lors de la sélection pour déplacer le cadre, de bien vérifier que 
c'est celui-ci qui possède les poignées vertes et non l'image intégrée. 

Un conseil : sélectionnez le cadre par sa ligne horizontale du bas.

Un clic droit sur le rectangle aux poignées vertes, ne doit montrer que les attributs du Cadre, 
et non les caractéristiques de l'image ( Images... et Enregistrer les images...) 

Le déplacement au-dessus ou en dessous d'un objet de même catégorie modifie 
automatiquement la numérotation.

La suppression de l'objet référencé se fait à partir de la sélection du cadre 
puis par la touche Suppr.
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Cas des tableaux de Writer et des cadres insérés

On remarque qu'aucun cadre dans ces deux cas n'est créé.

La légende s'inscrit à l'intérieur du cadre tandis que pour le tableau, elle s'inscrit dans le 
paragraphe suivant le tableau.

La sélection d'un tableau référencé se fait en plaçant le pointeur juste derrière le texte de la 
légende et glissant la souris vers le paragraphe vide au dessus du tableau 

Le déplacement de ce tableau référencé se fait par un copier-coller de cette sélection.
Sa suppression se fait par la touche Suppr à partir de cette sélection.

Le cadre référencé suit les mêmes règles que les Cadres insérés.

2.4. Modification des légendes

Comme signalé plus haut, l'ajout d'une légende insère l'image dans un cadre (sauf pour les 
tableaux).

Les règles d'affichage, d'édition et d'écriture suivent les règles des cadres.

1. Modifier le texte de la légende

Rappel : 
Touche Echap : une fois pour 

sélectionner le cadre,
une autre fois pour sortir 
du cadre

Cliquez sur le texte 
dans la légende Sélectionnez Corrigez ou tapez le 

nouveau texte. 

2. Modifier le format de la légende

Pour modifier l'apparence de toutes les légendes d'une même catégorie, il est préférable de 
passer directement par l'édition du style de paragraphe.

Chaque catégorie possède son propre style de paragraphe, les catégories par défaut 
comme celles que vous avez créées.

En cliquant dans la légende, le styliste F11 (boite de 
dialogue Styles et formatage) vous indique le style 
utilisé pour cette catégorie.

Ici le style Réf. , créé en même temps que la catégorie 
Réf.

Sélectionnez le style >
clic droit > Modifier... 

La boite de dialogue Style de paragraphe: Réf. permet de 
choisir les attributs désirés.

Retour au Sommaire   Les légendes dans Writer Page 11 sur 20



Onglet Effets de 
caractères 
pour la Couleur de 
police,...

ici Rouge

Onglet Alignement 
pour Centrer la 
légende par rapport à 
l'objet

Onglet Police pour la Police, le style (italique, gras...) et la taille (en pts)

Il  est  possible  de  surcharger  le  style  de 
paragraphe  en  ne  sélectionnant  que  le 
Titre  de  la  légende  par  exemple  et  lui 
appliquer  un  attribut  (ici  G gras  par  la 
Barre  de  formatage)  mais  seul  cet 
élément sera modifié.

Gras Italique gras A éviter dans la mesure du possible Surcharge

3. Modification de l'espacement entre l'objet et la légende

 Il est simple d'utiliser de changer l'espacement Simple par défaut.

Si vous estimez que la légende 
« colle » trop à l'objet

Cliquez sur le paragraphe à 
modifier pour repérer le style 
dans le Styliste F11
clic droit > Modifier...

Dans la boite de dialogue Style 
de paragraphe:xxx 
onglet Retrait et 
espacement 
zone Interligne 

Le choix de 1,5 ligne par la liste déroulante est beaucoup plus agréable à l'œil..
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On peut également choisir de 
fixer la valeur de l'interligne .

Choisir > Fixé
la zone numérique De
s'active, y tapez la valeur 
désirée en cm> 0,40 cm. 

Cet interligne se retrouvant sur 
les lignes suivantes montre la 
limite de ce réglage. ici 0,50 cm (valeur par défaut)

 Autre possibilité si le texte comporte plus 
d'une ligne.

Attention, il s'agit d'une manipulation qui 
met en jeu les objets insérés dans un cadre. 
En fait, il s'agit d'apporter les modifications 
aux objets AVANT de procéder à l'ajout 
d'une légende.
Elle s'applique également à postériori.

Il faut adapter le texte à l'objet (ici l'image)

Sélectionnez l'objet seul : Clic droit (image 
pour l'exemple) > Image... 

Dans la boite de dialogue Image, 
onglet Adaptation du texte >

ici, pour mieux voir la différence, 0,30 cm a été appliqué à cette exemple

Zone Espacement :
 En bas 
Tapez la valeur désirée. Elle est par défaut à 0,00 cm
La valeur de 0,20 cm convient mieux. 

Ceci est un montage...

4. Autres modifications

Positionner la légende à droite de l'objet par exemple
Une fois la légende créée, vous travaillez avec le cadre, 

l'objet et le paragraphe que forme le texte de la 
légende et son champ.

L'image est Ancrée Comme caractère, le paragraphe légende est copié-collé à côté.

Je ne peux que vous renvoyer à mon Tutoriel Tout sur les cadres     

Il est bien évident que l'on sort ici de la simple création automatique des légendes.
Il s'agit davantage de P.A.O. et d'autres méthodes seront préférables.
L'intégration des images dans un tableau et du texte dans une autre cellule pour la 
présentation est une méthode, voir un exemple ici , d'autres méthodes
en utilisant directement les champs (Variables et Renvois) pour la numérotation.

2.5. Suppression d'une Catégorie.

L'ajout d'une Catégorie crée un champ Variable de type Séquence.

Cliquez n'importe où dans la feuille de travail et Ctrl + F2 ou
menu : Insertion > Champs > Autres ...> 

Dans la boite de dialogue Champs, onglet Variables 
Dans la zone Type de champ (1) Cliquez sur Séquences 
s'affichent alors en Sélection (2) les différentes Catégories :
la catégorie sélectionnée s'affiche dans la zone Nom (3)
il s'agit du nom de la Catégorie de la légende.
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Voici la boite de dialogue Champs par défaut (d'un Nouveau document Texte)

Voici la boite de dialogue Champs de ma feuille de travail

Ce qui explique le refus de l'espace et de l'apostrophe, il s'agit en fait d'un nom de champ 
où la syntaxe de programmation ne les accepte pas. Retour à Ajouter une catégorie

Pour supprimer la Catégorie Copie_d_écran, la sélectionner dans la zone Sélection (2),
elle s'affiche dans la zone Nom (3) , le bouton x rouge (4) est actif pour la supprimer.

Note: si vous créez une Catégorie en la nommant dans la zone Nom (3) pour que la coche x 
soit active, il faut Insérer le champ, Fermer la boite de dialogue et l'ouvrir de nouveau 
par Ctrl+F2

Retour au Sommaire   Les légendes dans Writer Page 14 sur 20



2.6. Numérotation des objets par chapitres

1. Bouton Options :

Le bouton Options... de la boite de dialogue Légende permet de compléter la numérotation 
par l'indication du numéro du chapitre. 

Cela suppose que vous ayez défini la Numérotation automatique des chapitres et affecté à 
chaque niveau un style de titre et un style de numérotation.

Voir le tutoriel Tout sur les styles de Titres

Le bouton Options... ouvre la boite de 
dialogue Options 

Le Niveau correspond au Niveau 
indiqué dans la boite de dialogue 
Numérotation automatique 
Menu Outils > Numérotation 
des  chapitres... > 

Ici, le niveau 3 correspond au chapitre 
courant de ce document,

la valeur affichée sera donc le 2.6 du 
chapitre :

2.6 Numérotation des objets par 
chapitres

Les sous-chapitres de ce titre sont donc de niveau 4 mais ils ne comportent que 1 chiffre en raison de 
mon paramétrage d'affichage Complet à 1 au lieu de 4 possible (I.2.6.1)

2. Exemple d'une numérotation par chapitre d'un niveau x

Pour avoir une numérotation des figures 
suivantes par chapitre 

Le réglage est ici de niveau 3 qui 
correspond au chapitre 2.6

Icône 2.6.1: Icône 2.6.2: Icône 2.6.3: 

3. Exemple d'une numérotation par chapitre courant (niveau x+1)

Le réglage est ici de niveau 4 qui 
correspond au sous-chapitre courant 3, 
ce qui donne

Emoticône 3.1: Emoticône 3.2: Emoticône 3.3: 

 La numérotation par chapitre est attachée à la catégorie, dans l'exemple si dessus, 
si la catégorie n'avait pas été changée en Emoticône,pour montrer la différence 
d'affichage, nous aurions eu la continuité par rapport au chapitre 2.6 :

Icône 2.6.4: Icône 2.6.5: Icône 2.6.6: 
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4. Légende automatique

Le bouton Légende automatique donne accès directement à la boite de dialogue des options 
de OOoWriter, onglet Légende automatique,
Menu : Outils > Options > OpenOffice.org. Writer > onglet Légende 
automatique

A chaque insertion d'un nouvel objet, la légende est créée.

Ajouter des légendes automatiquement lors de l'insertion de : 
Dans la zone (1), sélectionnez le type d'objet pour lequel les paramètres de légende 
automatique doivent être valides.

Ici, à chaque création d'un tableau dans OOoWriter, le tableau sera affecté de sa légende dans la 
Catégorie Tableau (3).

Légende : (2)
Définissez les options à appliquer au type d'objet sélectionné. 

Ces options sont identiques à celles du menu 
Insertion > Légende, disponible lorsqu'un objet est 
sélectionné. 
On y retrouve tous les réglages et les Catégories déjà 
créées (3) :

Un aperçu (4) de la Catégorie de l'objet et du Type de 
numérotation s'affiche .

2.7. Conserver les catégories crées pour un travail ultérieur

1. Créer un modèle de document

Pour retrouver les Catégories lors d'un autre travail,

1. Enregistrer sous votre fichier. 

2. Sauvegardez ensuite ce document comme Modèle:
Menu : Fichier > Modèles >Enregistrer...

Dans la boite de dialogue Modèles ,
Tapez un nom explicite dans la zone Nouveau modèle de document 
Sélectionnez Mes Modèles dans la zone inférieure (Modèles : Catégories). 
Validez par OK.
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2. Adapter ce modèle 

Ce Modèle est la copie conforme du document origine. Il convient donc de le modifier pour 
qu'il soit (presque) immédiatement utilisable pour tout travail ultérieur. équivalent.

 Ouvrez le modèle pour l'éditer 
Menu : Fichier > Modèles > Éditer... 
l'extension du nom de fichier .ott ,le t de template remplace le d de odt.
le modèle s'ouvre : avec la 3.0 l'extension du nom de fichier devrait s'afficher

 Ne supprimez rien. 

Créer un cadre d'avertissement

 Créer un cadre en haut de votre document, après la partie que vous voudrez 
conserver comme modèle (Titre, Table des matières, etc) par exemple dans votre 
premier chapitre ;
Touche Suppr pour le dé-sélectionner ;
Cliquez dans le cadre ;

 Tapez un texte d'avertissement par exemple :
Cadre à ne supprimer qu'après avoir affecté une légende aux différents objets.

Insérer tous les champs des différentes catégories.

 En dessous, toujours dans le cadre, insérer tous les champs successivement ;
Menu: Insérer > Champs > Autres... ou Ctrl+F2
Dans la boite de dialogue Champs > onglet Variables 
Dans la zone Sélection,

Double-clic sur votre première catégorie créée : Emoticône par exemple, (équivalent au 
bouton Insérer.) 
et ainsi de suite Double-clic sur toutes les Catégories que vous voulez conserver 
(par exemple en oubliant Glaïeuls ce qui évitera de la supprimer !)

 En passant par l'affichage des noms des champs Ctrl +F9, vérifiez.

 Fermez la boite de dialogue Champs  par le bouton Fermer. 

  Effacez désormais tout ce qui se trouve plus bas, en plaçant le pointeur en 
dessous puis en en utilisant Maj + flèche directionnelle vers le bas
pour sélectionner , (surtout pas un Ctrl+A ! ), beaucoup plus commode 

Maj +

que par la souris puis touche Suppr.

  Clic droit sur votre Table des Matières  > Actualiser l'index/la table

Cadre à ne supprimer qu'après avoir affecté une légende aux différents objets.
3 312.7.12.7.12512.7.22.7.32.7.2

 Enregistrez simplement. Ctrl + S

Vous aurez ainsi sauvegardé vos catégories et leurs styles attachés et vous aurez un modèle 
propre, près à être utilisé par Menu : Nouveau > Modèles et Documents.
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3. Utiliser ces cibles (= Renvois) dans le document

Utiliser ces légendes numérotées comme cibles dans ce document , c-à-dire placer à un 
endroit précis du texte une Référence dirigeant vers l'objet cible (Renvois). 

L'utilisation d'une référence nécessite la création d'un champ Renvois.
Le menu : Insertion > Champs > Autres ... ou Ctrl+F2 ouvre la boite de dialogue Champs
onglet Renvois (ex Références, ce terme prêtait à confusion)

3.1. Cas d'un Nouveau document

Dans un Nouveau document, la zone 
Type de champ (1) ne comporte 
que 5 choix, la zone  Sélection (2) 
est inactive (grisé).

Si vous voulez utilisez un renvoi lié à 
l'ajout d'une légende, il faudra la 
créer préalablement.

Dans ce qui suit, la catégorie Glaïeuls a été affectée à trois images

3.2. Placer une référence dans un texte du document.

Texte exemple :
Si vous n'aimez pas les glaïeuls jaunes, allez voir si les ambres vous conviennent, sinon 
vous aimerez peut-être les grenats .

En initiation, placez dans le texte un texte d'information pour vous y retrouver , par exemple
(voir<2espaces>) (ici<2espaces>) que vous pourrez soit laisser soit effacer.

Si vous n'aimez pas les glaïeuls jaunes (voir  ), allez voir si les ambres (voir  )vous 
conviennent, sinon vous aimerez peut-être les grenats (ici  ).

Placez le pointeur à l'emplacement de la première Référence 

Ctrl+F2 >  Champs
 onglet Renvois

(1) Dans la zone 
Type de champ,
choisir la Catégorie 
Glaïeuls 

(2) Dans la zone 
Sélection,
sélectionner l'image 
cible

ici Glaïeuls1

(3)Dans la zone
Insérer une 
référence à 
choisir un affichage
ici Catégorie et numéro

Validez par le bouton 
Insérer.

Vous obtenez ceci 

(voir Glaïeuls 1 ) . 
Si vous obtenez (voir Glaïeuls ) , c'est Noms de champ qui s'affiche : Ctrl+F9 vite !
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(3)La zone Insérer une référence à  
permet de choisir l'affichage : 
par exemple Catégorie et numéro 
où la Catégorie est celle de la boite de dialogue  Légende de l'image donc en réalité le 
champ Glaïeul qui est créé lors de l'ajout de la légende,
où numéro est le nombre calculé de la numérotation +1

Pour obtenir Insérer une référence à (3)

Glaïeuls 2 Catégorie et numéro

2  seulement le numéro automatique Numérotation 

Glaïeuls : 2 Ambre Texte de référence

7 Le numéro de la page de la cible Page

2.3 Le numéro du chapitre de la cible Chapitre

7 Le numéro de la page en fonction de Style de page, 
onglet Page, zone Paramètres de mise en page.

D'après le Style de page,

supra ou infra par rapport à la position du renvoi.
= (voir au dessus, en dessous)

Supra/infra 

3.3. Modifier l'affichage de la référence après l'insertion

Se placer sur le champ à modifier 
clic droit, choisir  Champs...

Une nouvelle boite de dialogue d'édition s'ouvre 
Éditer les champs :: Renvois
Sont pré-sélectionnés le Type de champ, la 

Sélection,
Les deux boutons triangles noirs permettent de naviguer 

dans le texte et d'afficher ainsi les autres champs.

Il suffit de modifier l'affichage (3) Insérer une 
référence à 

Valider par OK
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4. Tableau, légende et Renvois

Exemple de contournement très simple pour insérer une image et sa légende avec une autre 
présentation.

 Créez un tableau de 2 colonnes. Suivant où vous voulez la légende, ici à droite, modifier la 
largeur des cellules en fonction du texte désiré et de la taille de l'image.

 Insérer votre image et tapez votre texte 

Ma légende à droite

 Clic droit sur l'image > Légende...>

Ma légende à droite

 Coupez-collez ( Ctrl X puis Ctrl +V ) la légende avant votre texte

Image 2 :Ma légende à droite


Réduisez le paragraphe devenu vide en 
dessous de l'image à 2 pts (tapez 2 dans 
la zone numérique Taille de la barre 
d'outils Formatage et Entrée)

Ancrage de l'image Comme caractère

Image 2: 

Image 2 : Ma légende àImage 2 : Ma légende à  
droitedroite

 Modifiez la présentation en utilisant les 
attributs des Tableaux et des 
Paragraphes, styles etc.

 icône centré verticalement (Tableau)

 icône centré (formatage) etc.

 En final, supprimez les bordures du tableau 

Glaïeuls Glaïeuls 33 : Grenat : Grenat

Mes photographies sont libres de droit .Mes photographies sont libres de droit .
Elles ont été prises dans les jardins de la Elles ont été prises dans les jardins de la 

Villa gallo-romaine de SéviacVilla gallo-romaine de Séviac
32250 MONTREAL-DU-GERS32250 MONTREAL-DU-GERS

Retour

 Je vous remercie de votre indulgence,  Je vous remercie de votre indulgence, 
surtout si vous n'aimez pas les glaïeuls.surtout si vous n'aimez pas les glaïeuls.
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